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Cyclooxygenase enzymes, mainly COX-1 and COX-2, have been shown to contribute to the
regulation of inflammation, pain, and physiological homeostasis, positioning them as critical
targets for the development of novel anti-inflammatory therapies. Although NSAIDs have
proven their efficacy in COX inhibition, their adverse effects have limited their use, highlighting
a research gap that necessitates further exploration of natural compounds, such as beta-sitosterol
(BS) and astaxanthin (AXT), as potentially safer, selective COX modulators. This study aimed
to explore the potential synergistic effects of BS-AXT combination in modulating COX
enzymes through molecular docking to discover their combined activity as safer, natural anti-
inflammatory agents. Docking results revealed that the BS-AXT combination significantly
enhanced the binding affinity of BS to COX-2, improving from -7.5424 kcal/mol (alone) to -
9.2033 kcal/mol in the combination form, indicating a potential synergistic interaction.
Consistent with previous docking studies, BS and AXT demonstrated similar binding behaviors,
dominated by hydrophobic interactions, particularly with key nonpolar residues within the
COX-2 active site. In conclusion, the docking results suggest that the BS-AXT combination
could be a natural COX-2 selective inhibitor, supporting the need for further studies to confirm
its effectiveness and safety.
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Introduction

Cyclooxygenase (COX) enzymes, especially COX-1 and
COX-2 isoforms, have been contributing to the proinflammatory
prostaglandins (PGs) synthesis from arachidonic acid, resulting in the
pathogenesis of inflammation and pain.%? Although COX-1 is
expressed constitutively and involved in physiological processes such
as gastric mucosa protective barrier and platelet function, inducible
COX-2 is significantly upregulated in response to inflammation and in
various cancers such as breast and colorectal cancers.>* Excessive
COX-2 activity promotes PG overproduction, resulting in chronic
inflammation.> Conventional COX inhibitors, such as non-steroidal
anti-inflammatory drugs (NSAIDs), are effective but frequently
associated with undesirable effects, such as gastrointestinal irritation
and cardiovascular issues, which has driven the search for safer,
naturally derived alternatives.®” Beta-sitosterol (BS), a phytosterol
found in plant-based foods, exhibits anti-inflammatory and antioxidant
properties through COX inhibition and modulation of oxidative stress
markers.®® Similarly, astaxanthin (AXT), a xanthophyll carotenoid
derived from marine sources, particularly Haematococcus pluvialis,
exhibits potent antioxidant activity and has shown inhibitory effects
on COX-1 and COX-2 through in silico studies.'%
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Although both compounds have been shown to exhibit COX inhibition
and promising anti-inflammatory effects, their combined efficacy has
not yet been explored.

Given the potential complementary mechanisms of BS and AXT,
which involve direct COX inhibition and attenuation of oxidative
stress, this study aimed to evaluate the potential of BS and AXT,
individually and in combination, as natural COX inhibitors, using
molecular docking analysis. The interactions of these compounds with
COX isoforms will also be compared to those of the standard COX
inhibitors, ibuprofen and celecoxib. This investigation could shed light
on the potential synergistic mechanism of the combination and its
viability as a safer anti-inflammatory and analgesic strategy.

Materials and methods

Materials

The chemical structures of four ligands: Ibuprofen (CID: 3672),
Celecoxib (CID: 2662), Beta-sitosterol (CID: 222284) and
Astaxanthin (CID: 5281224), were retrieved from the PubChem
database (https://pubchem.ncbi.nim.nih.gov) in the Simplified
Molecular Input Entry System (SMILES) format. The structures of the
target proteins, COX-1 (PDB ID: 6Y3C) and COX-2 (PDB ID:
3LN1), were retrieved from the RCSB Protein Data Bank
(https://www.rcsb.org) in the legacy PDB format.

Methods

Ligands and Proteins Preparation

All docking preparations and simulations were performed using
Molecular Operating Environment (MOE) software version 2015.10.
Ligands were constructed in 3D using the “Builder” module by
inputting SMILES strings, followed by geometry optimization and
assignment of partial charges.

The structures of the target proteins were prepared by removing
unwanted molecules such as water molecules, ligands, and redundant
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chains. Protonation states were adjusted using the Protonate 3D tool,
and missing residues were corrected in Structure Preparation mode.
The protein active sites were identified using the “Site Finder”
function and dummy atoms were placed to define the binding pocket
for docking.

Molecular Docking

Ligands were docked into both COX isoform active sites using the
MOE Dock mode. The docking process involved rigid receptor-
flexible ligand docking with the placement method set to “Triangle
Matcher” and refinement using “Forcefield”. The top scoring poses
were ranked based on binding energy (S score) and Root Mean Square
Deviation (RMSD), with poses showing RMSD < 2.0 A were
considered valid.*213

For combination docking, we used the sequence docking technique
instead of the merge docking technique to individually observe the
binding energies of the ligand combinations. BS was first docked into
the protein, followed by AXT. Both ligands were docked
simultaneously at the same site to evaluate potential synergistic
binding interactions. Each docking simulation was repeated in
triplicate to ensure the consistency of the results.

Visualization and Interaction Analysis
Docking interaction analyses were carried out using the BIOVIA
Discovery Studio Visualizer 2025. Ligand-receptor interactions were
visualized in both 2D and 3D formats. Hydrogen bonds and
hydrophobic interactions were assessed, and key residues were
identified and labeled accordingly.141

Methods by Modules

Module 1: Ligands Preparation

The chemical structures of four ligands; lbuprofen (CID: 3672),
Celecoxib (CID: 2662), Beta Sitosterol (CID: 222284) and
Astaxanthin (CID: 5281224) were retrieved from the PubChem
Database (https://pubchem.ncbi.nim.nih.gov) in the Simplified
Molecular Line Entry System (SMILES) format. These SMILES
strings were used to generate three-dimensional (3D) structures in
Molecular Operating Environment (MOE) software version 2015.10.
In the MOE, the ligands were constructed using the “Builder” module
by inputting SMILES strings. Each structure was minimized in energy
and prepared by applying geometry optimization and partial charge
calculations via the “Compute > Prepare > Partial Charges” function.
This process ensures proper electron distribution across atoms, which
is critical for accurate electrostatic and hydrogen bond interaction
prediction during docking. The optimized ligands were saved in the
“moe” format and imported into ligand database file “mdb” using the
MOE Database Viewer. Each ligand was added as a new entry to
facilitate the batch docking and further manipulation. This preparation
process consistently applied to both individual and combination
docking simulations, including the redocking validation.

Module 2: Protein Preparation

The structures of COX-1 (PDB ID: 6Y3C) and COX-2 (PDB ID:
3LN1) were downloaded from the RCSB Protein Data Bank
(https:/iwww.rcsh.org) in Legacy PDB format. These structures were
selected on the basis of their resolution and relevance to NSAID
binding. The protein files were loaded into MOE 2015.10.

Protein preparation involved the removal of all heteroatoms, including
co-crystallized ligands, water molecules and redundant chain,
retaining only chain A for COX-1 and COX-2 in protein sequence
“SEQ” function. The “Structure Preparation” tool was used to correct
missing atoms or residues and optimize protein geometry.
Subsequently, the “Protonate 3D” function was applied to assign the
correct protonation states at physiological pH, which ensured an
appropriate charge distribution and hydrogen bonding during docking.
The binding site was identified using MOE’s “Site Finder” function to
detect potential ligand-binding pockets. Alpha spheres were initially
used to define the cavities, and dummy atoms were placed at the
predicted binding site to guide docking. The binding site was refined
by setting visualization parameters (“Render: Alpha Centers > No
Centers” and “Isolate: None > Atoms and Backbone”) to enhance
docking focus and computational efficiency. The prepared protein
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structures were saved in “moe” format for subsequent docking
procedures

Module 3: Docking of Ligands on Proteins

The prepared proteins (COX-1 and COX-2 in “moe” format) were
loaded into the MOE 2015.10. Docking simulations were initiated
through the “Compute > Dock” function. The binding site was defined
using previously applied dummy atoms. Under the “Site” section,
“Ligand Atoms” was set to “Dummy Atoms” to restrict docking to the
active site.

In the docking window, under the “Ligand” section, input was set to
“MDB File” and the ligand database viewer file containing the
prepared ligand was selected. The “Output” path was defined to save
the docking results. Each ligand was docked individually to COX-1
and COX-2 using the Triangle Matcher placement method and
Forcefield refinement.

Docking results were displayed in the database viewer, where poses
were evaluated based on Root Mean Square Deviation (RMSD). Poses
with the RMSD < 2.0 A were considered valid, indicating that the
predicted ligand orientation was close to the optimal native binding
mode. Docking for each ligand was repeated three times to ensure
consistency. The best pose with the lowest binding energy, marked by
the “S” symbol, was saved for the visualization by selecting the pose,
clicking “Keep” and exporting it in “Tripos MOL2” format as Ligand-
Protein Docked Posel”.

Module 4: Ligand Combination Preparation

For combination docking, the database viewer files of beta-sitosterol
(Ligand C) and astaxanthin (Ligand D) were first duplicated and
opened in separate windows in MOE. Using Ligand C’s database
viewer, the molecular structure was copied using “Copy As > MOE”.
In the Ligand D’s viewer, a new empty entry was created via “Edit >
New > Entry” and the copied Ligand C structure was pasted into this
field. Both ligand entries (C and D) were selected, and the combined
database was saved using “File > Save As” and named “Ligand C-D
Complex Database Viewer” in “mdb” format. This file enabled the
sequential docking of both compounds at the same active site.

Module 5: Combinatorial Docking of Ligands

To perform sequence docking, the prepared protein file was reopened
on MOE 2015.10. Docking was started via “Compute > Dock”. The
binding site was defined using “Dummy Atoms” under the “Site”
section, as previously set during site identification. In the “Ligand”
section, the input was changed to “MDB File” and the combination
file “Ligand C-D Complex Database Viewer” was loaded. The
“Output” path was selected and saved as “Ligand C-D Combination-
Protein Docked”. Docking was executed by clicking “Run”.

The docking results for ligands C and D were analyzed individually.
Poses with the RMSD < 2.0 A were retained, and those with the
lowest binding energy were selected as optimal. Each selected pose
was kept in the active site using “Keep” for both ligands and the
resulting complex was saved in “Tripos MOL2” format as “Ligand-
Protein Co-docked Pose 1. This sequence docking allowed for the
analysis of how each ligand contributed to the binding site, simulating
potential synergistic effects.

Module 6: Visualization of Ligand-Protein Interactions

The ligand-protein complex interactions were analyzed using BIOVIA
Discovery Studio Visualizer 2025. The docked “MOL2” files
(“Ligand-Protein Docked Pose 1” and “Ligand-Protein Co-docked
Pose 1) were opened using “File > Open”.

For single docking visualization, 3D and 2D interaction maps were
generated via “Receptor-Ligand Interactions > View Interactions”.
The “Ligand Interactions” and “Show 2D Diagram” options were used
to display the binding residues and interaction types. Unfavorable
interactions were removed by right-clicking the interaction, selecting
“Display Style” and unticking the undesired categories. For the ligand
celecoxib, which may have delocalized bonds, the “Chemistry > Bond
> Localize Bonds” function was used to correct bond visualization.

For co-docking analysis, the same process was repeated using
“Ligand-Protein Co-docked Pose 1”. The interactions of each ligand
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were viewed separately using the “Step Through Ligands” arrow tool.
Interaction diagrams and binding site residues were labeled in the 3D
viewer for a clearer presentation of the hydrophobic and hydrogen
bonding patterns.

Results and discussions

This section presents the molecular docking results of ibuprofen (1B),
celecoxib (CX), beta-sitosterol (BS), and astaxanthin (AXT), both
individually and in combination, against both COX isoforms. Table 1
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presents the results related to COX-1 whereas Table 2 presents results
for COX-2. Ligand-protein interactions were analyzed using 2D
interaction diagrams and 3D visualizations. Key binding residues,
bond types, and binding affinities have been reported previously. IB
demonstrated a binding energy of -6.3164 kcal/mol with COX-1,
forming hydrogen bonds with HIS A:43 and LYS A:468. Meanwhile,
hydrophobic interactions were observed with CYS A:36, A:41, A:47,

HIS
A43
LYs ARG
LEU AA6E A469

ALS2

| | Akl
| | Ayl

Figure 1 : Interaction of Ibuprofen with Cyclooxygenase-1 (COX-1). (a) 2D interaction showing the binding of ibuprofen to residues
within the COX-1 active site. (b) 3D visualization of Ibuprofen spatial orientation and binding pocket topology within the active site.

PRO A:40, A:153, LEU A:152 and ARG A:469 (Figure 1). On COX-
2, the binding energy was slightly lower (-6.2170 kcal/mol).
Interactions included hydrogen bonds with ASN A:28 and GLN A:27,
and hydrophobic contacts with CYS A:26, A:32, PRO A:25, A:139,

LEU A:138, LYS A:454 and ARG A:455 (Figure 2). CX produced a
binding energy of -7.4058 kcal/mol with COX-1 through conventional
hydrogen bonds with GLU A:465, CYS A:41, and GLN A:42; carbon-
hydrogen bonds with ARG A:469 and TYR A:130; and a halogen
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(fluorine) bond with ILE A:151. Hydrophobic alkyl and pi-alkyl
interactions were observed with CYS A:36, A:47, ILE A:46, LEU
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strongly (-7.5955 kcal/mol), forming hydrogen bonds with GLU
A:451

A:152, and PRO A:153 (Figure 3). With COX-2, CX bound more
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Figure 2 : Interaction of lbuprofen with Cyclooxygenase-2 (COX-2). (a) 2D interaction showing the binding of Ibuprofen to residues
within the COX-2 active site. (b) 3D visualization of Ibuprofen spatial orientation and binding pocket topology within the active site.

and CYS A:21, a halogen bond with CYS A:26, and hydrophobic
contacts with TYR A:116, PRO A:139, LEU A:138, ARG A:455, and
LYS A:454 (Figure 4). BS showed a binding energy of -7.1971
kcal/mol with COX-1 through conventional hydrogen bonds with
ARG A:120 and GLU A:524, and hydrophobic contacts with LEU
A:123, VAL A:119, ARG A:79, TYR A:64, and HIS A:43 (Figure 5).

In COX-2, no hydrogen bonding was observed, but hydrophobic
interactions were detected with CYS A:21, A:26, A:32, ARG A:29,
A:455, LEU A:138, PRO A:139, and LYS A:454, resulting in a
binding energy of -7.5424 kcal/mol (Figure 6). AXT displayed strong
binding with COX-1 at -9.9239 kcal/mol, forming hydrophobic
interactions with CYS A:36, A:47, HIS A:43, ILE A:46, LEU A:152,
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PRO A:153, A:156, LYS A:468, and LYS A:473 (Figure 7). With
COX-2, AXT demonstrated the highest binding energy of -10.4797
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LYS A:454, and hydrogen bonding with SER A:457 (Figure 8). In the
co-docked complex with COX-1, BS displayed a slightly improved

kcal/mol, involving extensive hydrophobic interactions with CYS binding energy (-7.6037
A:21, A:32, ARG A:29, TYR A:122, PRO A:139, ALA A:142, and
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Figure 3 : Interaction of Celecoxib with Cyclooxygenase-1 (COX-1). (a) 2D interaction showing the binding of Celecoxib to residues
within the COX-1 active site. (b) 3D visualization of Celecoxib spatial orientation and binding pocket topology within the active site.
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Figure 4 : Interaction of Celecoxib with Cyclooxygenase-2 (COX-2). (a) 2D interaction showing the binding of Celecoxib to residues
within the COX-2 active site. (b) 3D visualization of Celecoxib spatial orientation and binding pocket topology within the active site.
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Figure 5 : Interaction of Beta-Sitosterol with Cyclooxygenase-1 (COX-1). (a) 2D interaction showing the binding of Beta-Sitosterol to
residues within the COX-1 active site. (b) 3D visualization of Beta-Sitosterol spatial orientation and binding pocket topology within the

active site
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Figure 6 : Interaction of Beta-Sitosterol with Cyclooxygenase-2 (COX-2). (a) 2D interaction showing the binding of Beta-Sitosterol to
residues within the COX-2 active site. (b) 3D visualization of Beta-Sitosterol spatial orientation and binding pocket topology within the
active site.
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Figure 7: Interaction of Astaxanthin with Cyclooxygenase-1 (COX-1). (a) 2D interaction showing the binding of Astaxanthin to
residues within the COX-1 active site. (b) 3D visualization of Astaxanthin spatial orientation and binding pocket topology within the
active site.

kcal/mol), forming hydrogen bonds with HIS A:43, van der Waals
interaction with LYS A:468, and hydrophobic interactions with CYS
A:36, A:47, LEU A:152, PRO A:153, and A:156. AXT achieved
enhanced binding (-10.0867 kcal/mol), forming pi-alkyl interactions
with CYS A:36, A:47, HIS A:43, LEU A:152, PRO A:153, A:156,
LYS A:468, and LYS A:473 (Figure 9). 2D interaction of complex
Ligands binding within COX-1 active site also shown in Figure 10.

BS in complex form had enhanced binding energy of -9.2033
kcal/mol, forming a carbon-hydrogen bond with ASN A:28 and
hydrophobic contacts with CYS A:21, A:32, ARG A:29, LEU A:138,
PRO A:139, ALA A:142, LYS A:454, and ARG A:455. AXT showed

the strongest overall affinity (-10.7948 kcal/mol), forming hydrogen
bonds with SER A:457 and LYS A:68, and extensive hydrophobic
interactions with CYS A:21, A:32, ARG A:29, PRO A:139, ALA
A:142, LYS:454, and PRO A:460 (Figure 11). 2D interaction of
complex Ligands binding within COX-1 active site also shown in
Figure 12.

As shown in Table 3, IB and BS did not share any common interacting
residues with COX-1. However, IB and AXT shared CYS A:36, HIS
A:43, CYS A47, LEU A:152, PRO A:153, and LYS A:468. No
overlapping residue was observed between CX and BS, whereas CX
and AXT shared CYS A:36, ILE A:152, and PRO A:153. In the
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CYS A:36 and CYS A:47. CX and BS shared CYS A:36, CYS A:47,
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Figure 8 : Interaction of Astaxanthin with Cyclooxygenase-2 (COX-2). (a) 2D interaction showing the binding of Astaxanthin to
residues within the COX-2 active site. (b) 3D visualization of Astaxanthin spatial orientation and binding pocket topology within the

active

LEU A:152, and PRO A:153, while CX and AXT interactions
included CYS A:36, LEU A:152, and PRO A:156.

For COX-2, IB and BS shared CYS A:26, CYS A:32, LEU A:138,
PRO A:139, LYS A:454, and ARG A:455. IB and AXT overlapped
with CYS A:32, PRO A:139, and LYS A:454. CX and BS shared CYS
A:21, ARG A:29, PRO A:139, LYS A:454, and ARG A:455, whereas

site.

CX and AXT shared CYS A:21, ARG A:29, and LYS A:454. In the
combination form, IB and BS shared ASN A:28, CYS A:32, LEU
A:138, PRO A:139, and LYS A:454. CX and BS shared CYS A:21,
ARG A:29, PRO A:139, LYS A:454, and ARG A:455, whereas CX
and AXT shared CYS A:21, ARG A:29, and LYS A:454. The binding
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energies of each ligand against COX isoforms are summarized as COX-1: AXT (combination, -10.0867) > AXT (single, -9.9239) > BS
follows: (combination, -7.6037) > CX (-7.4058) > BS (single, -7.1971) > IB (-
6.3164

Figure 9 : Binding of Complex into COX-1 active site binding pocket

[ 4 RO
A 2o A0
LEL
ALS2
| ’
|
S / ’ s e T L
AL /‘\\.. X ' "
s py 4 S R
. l " \ IR RS k "
. Py e Wa. \ H
LYs - S i F n" u'\" \\
AXGH '-“___ : o
W - NS T™™
W "
& K
cYs
A7
RO
A5
Interactmns
I | -V | Ay
B Cvvarrsana vy agen: st
@)
o HIS oS
A473 A4z o a47
LY
Aasd PRO
A153
R
’-‘\ r \ ” .,
X Y e / 3 2. 4
> ! A\ — /r—d /4
Y/, \ A\ -\ / \
D,/ \ \\\. - [ M \\ // -— <</ \;L /';
Y»— \ B ¢ !
" \1 77 L ' \
Y/ B o —
g *'-' ”:J —:u
i M
L£uU PRO s
AlsD A 156 A3E
Imteractioms
l_.. o == Ak
(b)

4410
© 2025 the authors. This work is licensed under the Creative Commons Attribution 4.0 International License



Trop J Nat Prod Res, September 2025; 9(9): 4400 - 4417 ISSN 2616-0684 (Print)
ISSN 2616-0692 (Electronic)

Figure 10 : 2D interaction of complex Ligands binding within COX-1 active site. (a) Beta-Sitosterol, (b) Astaxanthin.
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Table 1 : Molecular docking interactions of Ligands into COX-1

Name

Ligand

of Binding Energy RMSD Value
(kcal/mol)

Hydrogen Bonding

Conventional

Carbon-Hydrogen

Hydrophobic Interactions

Alkyl and Pi-Alkyl

Others

Ibuprofen

Celecoxib

Beta-Sitosterol
(Single)

Astaxanthin
(Single)

Beta-Sitosterol
(Complex)

Astaxanthin
(Complex)

-6.3164 1.6322

-7.4058 1.2051

-7.1971 1.7905

-9.9329 1.0690

-7.6037 1.6251

-10.0867 1.8291

HIS A:43
LYS A:468

CYSA41

GLNA:42

TYRA:130
ARG A:469
GLU A:465
ARG A:120
GLUA524

HISA43

LYSA: 468

CYSA:36
PRO A:40
CYSA41
CYSA47
LEU A:152
PROA:153
ARG A:469
CYSA:36
ILEA:46
CYSA47
LEU A:152
PROA:153
HISA:43
TYRA:64
ARGA:79
VALA:119
LEUA:123
CYSA:36
HISA:43
ILEA:46
CYSA47
LEU A:152
PROA:153
PRO A:156
LYS A:468
LYS A:473
CYSA:36
CYSA47
LEU A:152
PROA:153
PRO A:156
CYSA:36
HIS A:43
ILEA:46
CYSA47
LEUA:152
PRO A:156
LYS A:468
LYSA473

ILEA: 151

(Halogen — Fluorine)

LYS A:468
(Van der Waals)
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COX-2: AXT (combination, -10.7948) > AXT (single, -10.4797) >
BS (combination, -9.2033) > CX (-7.5955) > BS (single, -7.5424) >
IB (-6.2170)

The BS binding energy improved from -7.5424 kcal/mol to -9.2033
kcal/mol for COX-2, particularly in complex form, suggesting a
synergistic effect when combined with AXT.
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This study was performed to investigate the potential synergistic effect
of BS-AXT combination on COX enzymes using molecular docking
techniques. This study aimed to compare the binding affinity and
interaction profiles of BS-AXT in combination with individual
compounds and standard COX inhibitors including ibuprofen (IB) and
celecoxib (CX). The structural features of BS and AXT enable key

Table 2 : Molecular docking interactions of Ligands into COX-2

Name of Binding Energy RMSD Value Hydrogen Bonding

Ligand (kcal/mol) Conventional

Hydrophobic Interactions

Carbon-Hydrogen Alkyl and Pi-Alkyl Others

Ibuprofen -6.2170 1.1298 GLNA:27
ASN A:28

CYSA:21
ARGA: 29

Celecoxib -7.5955 1.6054

Beta-Sitosterol -7.5424 0.6867
(Single)

Astaxanthin -10.4797 0.9583 SER A:457

(Single)

Beta-Sitosterol -9.2033 11713
(Complex)

PROA:25
CYSA:26
CYSA:32
LEUA:138
PROA:139
LYS A:454
ARG A:455
LEUA:138 CYSA:26
PROA:139
LYSA:454
ARG A:455

(Halogen-Fluorine)
TYRA:116
(Pi-Pi T-shaped)
GLUA:451
(Halogen-Fluorine)

CYSA21

CYSA:26

ARG A:29

CYSA:32

LEU A:138

PRO A:139

LYS A:454

ARG A:455

CYSA21

ARG A:29

CYSA32

TYRA:122

PRO A:139

ALAA:142

LYSA:454
ASN A:28 CYSA21

ARG A:29

CYSA32

LEU A:138

PRO A:139

ALAA142

LYS A:454

ARG A:455
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Astaxanthin -10.7948 1.2850 SER A:457 LYS A:68 CYSA:21
(Complex) ARG A:29
CYSA:32
PRO A:139
ALAA:142
LYS A:454
PRO A:460
Table 3 : Common amino acid residues interactions among ligands
Protein Ligand Pairs Common Interactions
COX-1 Ibuprofen and Beta-Sitosterol -
Ibuprofen and Astaxanthin CYS A:36, HIS Ai43, CYS Ai47, LEU A:152, PRO A:153, LYS A:468
Celecoxib and Beta-Sitosterol -
Celecoxib and Astaxanthin CYS A:36, ILE A:46, CYS A:47, LEU A:152, PRO A:153
Ibuprofen and Beta Sitosterol Complex CYS A:36, CYS Ai47, LEU A:152, PRO A:153
Ibuprofen and Astaxanthin Complex CYS A:36, CYS Ai47, LEU A:152
Celecoxib and Beta Sitosterol Complex CYS A:36, CYS Ai47, LEU A:152, PRO A:153
Celecoxib and Astaxanthin Complex CYS A:36, CYS Ai47, LEU A:152, CYS A:468
COX-2 Ibuprofen and Beta-Sitosterol CYS A:26, CYS A:32, LEU A:138, PRO A:139, LYS A:454, ARG A:455

Ibuprofen and Astaxanthin

Celecoxib and Beta-Sitosterol
Celecoxib and Astaxanthin

Ibuprofen and Beta Sitosterol Complex
Ibuprofen and Astaxanthin Complex
Celecoxib and Beta Sitosterol Complex
Celecoxib and Astaxanthin Complex

CYS A:32, PRO A:139, LYS A:454

CYS A21, ARG A:29, LEU A:138, PRO A:139, LYS:454, ARG A:455
CYSA: 21, ARG A:29, PRO A:139, LYS A:454

ASN A:28, CYS A:32, LEU A:138, PRO A:139, LYS A:454, ARG A:455
CYS A:32, PRO A:139, LYS A:454

CYSA21, ARG A:29, LEU A:138, PRO A:139, LYS A:454, ARG A:455
CYSA21, ARG A:29, CYS A:32, PRO A:139, LYS A:454

0
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interactions with both the COX isoforms. BS has a hydrophobic
steroid backbone, while AXT has a long-conjugated polyene chain,
allowing the formation of hydrogen bonds, pi-alkyl stacking, and
hydrophobic interactions, which help stabilize the ligand-protein
complex, contributing to COX inhibition.**Y” The docking results
suggested a possible selective COX-2 inhibition over COX-1, which is
a desirable trait in anti-inflammatory drug design.

COX-1 and COX-2 have almost identical active sites, but differ in key
residues, such as 11e523 in COX-1 and Val523 in COX-2, allowing the
COX-2 isoform to bind with bulkier ligands. Residues such as
Arg120, Tyr355, and Glu524 form the active site entrance, whereas
Arg513 and Val434 in COX-2 improve ligand fit through polar and
spatial interactions to determine how inhibitors selectively bind to
COX-2.181% pharmacophore models highlighting the importance of
hydroxyl, carboxyl, and hydrophobic groups for effective interactions
with key residues, such as Argl120, Tyr 355, and Val523. Asiatic acid
showed good binding energy and mimicked COX-2 inhibitors, such as
CX, owing to its carboxyl group.?°

BS is a plant sterol that is structurally similar to cholesterol,
comprising a steroid backbone as a core structure and a long
hydrophobic chain at C17 with one polar hydroxyl group attached at
C3.18 This hydrophobic structure allows BS to enter the lipophilic
COX pocket, interacting mainly through van der Waals and
hydrophobic interactions with nonpolar residues, such as alanine,
valine, and leucine, and hydrogen bonding is limited because of the
less polar group.?+?22  The bhinding energies of BS to COX-1 and
COX-1 were -7.1971 kcal/mol and -7.5424 kcal/mol, respectively. In
the previous studies, BS interaction with COX preferentially bound to
COX-2 over COX-1, as evidenced by the stronger binding energy of
COX-2, as per our study. The binding energies produced by BS on
COX varies across studies, ranging from -3.1 kcal/mol to -5.5
kcal/mol on COX-1,%#%% and -6.54 kcal/mol to -12.38
kcal/mol,?"?82%30 depending on the protein conformation and docking
tools with most of them had the average of -7 kcal/mol on COX-2
especially, which was comparable with our study. In all these cases,
BS mainly interacted with hydrophobic residues, such as valine,
leucine, tyrosine, and phenylalanine.

Binding interactions with COX isoforms were mainly hydrophobic at
residues Cys21, Cys32, Leul38, Argl20, and Tyr64. As shown in
Table 3, BS in single docking did not show direct overlapping of the
interaction residues with either 1B or CX. However, in the
combination form with CX or IB, common residues such as CYS
A:36, LEU A:152, and PRO A:152 were observed, suggesting that BS
binding affinity was enhanced when in combination. Meanwhile, on
COX-2, BS demonstrated stronger overlap with standard inhibitors
interacting residues, such as CYS A:21, ARG A:29, PRO A:139, LYS
A:454, and ARG A:454, which were identified in both single and
combination forms. These residues are essential for COX-2 binding
and catalytic activity, indicating that BS may closely mimic the
orientation and interactions of the COX-2 selective inhibitor CX.
Studies have consistently reported that BS binds to common COX-2
residues such as Tyr255, Leu352, Val349, Ala527, and Met522, 28.29.30
Important residues, such as Tyr385 and Arg120, play important roles
in substrate binding and peroxidase function, and appear repeatedly in
COX-1 and COX-2 docking studies. This indicates that these residues
may act as conserved binding hotspots for BS.2"%%

AXT is a carotenoid with a long, conjugated polyene chain that makes
it hydrophobic, and shares a similar structure with other carotenoids,
such as beta-carotene and lycopene, which helps it fit into the
hydrophobic pocket of the COX active site.”:3 Because of this
similarity, it is often compared with other carotenoids.®* Although
AXT shares this similarity, its additional polar groups (hydroxyl and
keto) at the ends of the chain differ from those of other the
carotenoids, making it more amphipathic.*® The binding energy of
AXT showed favorable binding to COX-2 compared to COX-1, as
demonstrated by the stronger binding energies of -10.4797 kcal/mol
for COX-2 and -9.9239 kcal/mol for COX-1. Prior research
demonstrated that the AXT binding energy on COX-1 was -8.2
kcal/mol,** while on COX-2, it ranged from -7.2 to -8.722
kcal/mol, 363738 which were considered strong binding, although lower
than those obtained in our study.

ISSN 2616-0684 (Print)
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As shown in Table 3, AXT showed more promising individual overlap
with standard COX-1 interactions than BS. In COX-1, AXT alone
shared residues such as CYS A:36, LEU A:152, and PRO A:153 with
both IB and CX. The presence of these overlapping residues suggests
that AXT binds to a similar region of the active site as standard
NSAIDs, supporting its potential to inhibit COX-1 activity on its own.
On COX-2, AXT exhibited favorable alignment with standard
inhibitors. Residues such as PRO A:139 and LYS A:454 were shared
with 1B and CX. The conservation of these interactions indicates that
AXT, similar to BS, may engage in critical COX-2 residues that are
essential for effective inhibition. Previous docking studies showed that
AXT bound COX-2 preferentially compared to COX-1 through
hydrophobic interactions (alkyl and pi-alkyl) with residues such as
Lys211, His214, and Val291, as well as hydrogen bonding with
His386 and Asn382.37:38

Through the combination docking of BS and AXT, this study
demonstrated an enhancement in the binding energy of BS to COX-2,
which improved from -7.5424 kcal/mol in single docking to -9.2033
kcal/mol in combination docking with AXT. This enhanced binding
energy was also higher than that of standard COX inhibitors, as
presented in Table 2 and Figure 13. This enhancement indicated a
synergistic effect of the combination, proving that AXT might help BS
to interact with the COX-2 pocket through an in silico approach.
Although no previous study has directly explored the combination of
BS and AXT on COX, existing evidence suggests that combining a
lipophilic compound, such as BS, with the antioxidant AXT may
enhance its binding and biological effects. Both compounds showed
synergistic effects when combined with other agents. BS improved
anticancer  effects in  combination with hydrastinine and
stigmasterol.*4% Meanwhile, AXT enhanced the anti-inflammatory
action of celecoxib, and boosted antioxidant and anti-inflammatory
response in the mixed compounds with vitamin C, collagen peptides,
and resveratrol.442 This finding supports the potential of BS and AXT
to work together more effectively than individually, possibly leading
to stronger COX inhibition through complementary binding
interactions.

Conclusion

The combination of BS and AXT produced stronger and more stable
binding to COX-2 than either compound alone, as evidenced by the
improved BS binding energy from -7.5424 kcal/mol (alone) to -9.2033
kcal/mol (combination) for COX-2. It demonstrated improvement in
binding affinity and interaction diversity, particularly through
enhanced hydrophobic contacts from BS and AXT, and additional
hydrogen bonds contributed by AXT. These complementary
interactions suggest a possible synergistic effect that stabilizes the
ligand-protein complex, especially within the COX-2 pocket. This
binding pattern resembled that of known COX-2 inhibitors, indicating
potential for reduced side effects. These findings support the concept
that the combination of phytosterol and xanthophyll carotenoids can
naturally enhance COX-2 inhibition. Further in vitro and in vivo
studies are necessary for the verification of these promising results.
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